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This month’s e-focus features Part I of 
Joe Ramsey’s great December DIPSIG 
talk on “Turning Day Into Night”. 
Jerry Dupree also kicks off a new 
series “Love Me – Love My DIG” that 
will feature member experiences with 
their digital cameras.

We also introduce a new column by 
Woody Kaplan – Woody’s Corner 
– that will showcase bargains that can 
be purchased and other items related 
to changing technology. We challenge 
any member to find a better price than 
Woody!

Stuart Lynn also presents Part I of a 
(somewhat) short primer on “layers” 
for beginners, a topic that should no 
doubt have been discussed before last 
month’s Beginners’ Page article on 
Layer Masking. Oh well!

Stuart also reviews the subject 
of “Transition Masks” and gives 
examples of how they can be put to 
work.

 A Happy (and very Digital) New Year 
to all readers! – Ed



– 2 –

Turning Day into Night - Part 1
by Joe Ramsey 

Filmmakers have used filtering, lighting and 
exposure techniques for many years to turn 
daylight scenes into night on film. Now using 
Photoshop you can get the same effects in your 
still photos. Thanks to Sean Duggan’s MacDesign 
tutorial for this technique that we’re applying to 
a photo taken in Bodie.

To begin choose a photo (Figure 1) such as an old 
mansion, a photo from a ghost town or any scene 
that might be suitable for a night treatment.

    Fig 1: Ghost Town in Daylight

To get the muted blue color seen at night we 
need to add a Hue/Saturation Layer. In the 
Options Bar go Layer>New Adjustment Layer>Hue/
Saturation. In the dialog box click Colorize. Set Hue 
to 220 and Saturation to 30. Click OK then lower 
the layer opacity to 40-50% (Figures 2 and 3).

Fig 2: Hue-Saturation Applied

Fig 3: Hue/Saturation Settings

Next we’ll darken the scene and increase contrast 
by adding a Curves Adjustment Layer. Go to 
Layer>New Adjustment Layer>Curves. Adjust 
(Figure 4) the curve as shown, click OK then 
lower Opacity of this curves adjustment layer to 
around 50%. 

                      

Fig 4: Adding Curves Adjustment Layer 

Now let’s make a deep blue night sky. Using 
your choice of selection tools select the sky area 
of your image. With the sky selection active add 
a Color Fill Layer. Go Layer>New Fill Layer>Solid 
Color. When the Color Picker appears choose a 
suitable dark blue shade for the sky and click OK. 
  
Like magic (Figure 5) your sky selection is turned 
into a layer mask so that the blue fill is visible 
only in the sky. If  the selection had been ‘off’ 
the entire layer would be blue with nothing else 
visible.
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Fig 5: Blue Fill in Sky After Curves Adjustment

Well, the blue sky is nice but what about stars 
you ask. No problem. Click the New Layer icon 
(Figure 7) at the bottom of the Layers Palette. 
See illustration. Be sure the new layer is at the 
top of your Layers Palette. Press “d” for default 
colors (B&W) making sure that Black is set as 
Foreground color.
            

Fig 7: Add a New Layer

Press Alt+Backspace (PC)/Option+Delete (Mac) to 
fill the New Layer with black. Or, you can use the 
Paint Bucket which also fills with the Foreground 
color. While we’re at it if you press Backspace 
((PC)/ Shift+Delete (Mac) the Fill dialog box pops 
up where you can select black fill.

Fig 7: Black Fill Layer with Add Noise Dialog 

So where are the stars? They’re coming. With the 
black filled layer active go to the Filter menu. 
Choose Noise>Add Noise. Adjust the noise settings 
to 40, Gaussian and Monochromatic (Figure 7). 
Click OK. To soften the edges of the noise go 
Filter>Blur>Gaussian Blur and adjust the radius 
to 1.5 pixels.

Here is where you make the stars shine. Go Im
age>Adjustments>Threshhold. Move the slider to 
the left until you see a reasonable number of stars 
and click OK. Set the layer blend mode at the top 
of the Layers Palette to Lighten. Now we’ll run the 
Gaussian Blur filter one more time with a radius 
setting of 0.5.

Wow! We’ve got stars but they’re all over the 
place. To make them shine only in the sky press 
Ctrl+click/Cmd on the Layer Mask in the Blue 
Color Fill layer. This will load the mask of the 
sky as a selection. Click the stars layer to make 
it active and go Layer>Add Layer Mask>Reveal 
Selection. Hit Ctrl/Cmd+d to turn off the sky 
selection and there you have it - another way to 
mask a selected area and turn daylight into night 
with stars in the sky (Figure 8). 

Fig 8: Ghost Town at Night

For final touches go to the Hue/Saturation and/or 
Curves Adjustment layers that you created and 
fine tune the settings until your Day-Into-Night 
effect looks just right.

Save your files from this exercise. We’ll use them 
in Part 2 to replace the stars with storm clouds, 
add rain, turn on a light in that forlorn miners 
cabin and maybe even light a fire in the fireplace.    
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th
e dipsig page

DIPSIG is the Digital 
Photography Special 
Interest Group of the 

Coachella Valley Desert 
Camera Club. It meets 

monthly (except July 
and August) at 6.30 pm 

at the Courtyard Mar-
riott at the corner of 

Cook and Frank Sinatra 
in Palm Desertby Joe Ramsey

January 20 DIPSIG Meeting:
Selections and More!

Making Better Selections in Photoshop

We all know about selection tools because 
we use them frequently and have a favorite 
or two. But are we using the best tool for each 
particular job?  Are we making the most effective 
adjustments? It can be a daunting task. For 
instance, did you realize that there are three 
variations of the Lasso tool, four variations of the 
Marquee tool and a Magic Wand selection tool. 
You can also make selections by Color Range 
or Luminosity (Photoshop 6.0 or higher) or by 
applying Brush and Pencil tools either alone 
or in combination with masks and channels. 
Then to compound our dilemma every tool 

has adjustments that affect it’s application. If 
you are feeling somewhat intimidated by now, 
fret no more. Stuart Lynn will expand our bag 
of Photoshop Selection tricks at our January 
meeting when he discusses  “Ten Ways to Make 
Better Selections in Photoshop”. Knowing 
Stuart we can expect a very thorough and 
lucid presentation that will hone your selection 
techniques to expert levels.

Resizing Images

Even though some guidelines were presented 
in our club newsletters there are still questions 
regarding resizing images. We’ll try to shed 
some light on this question with a discussion 
of resizing images loaded into your computer 
from various sources. Which settings should be 
used and which should be avoided. Also, we 
will discuss how the intended use of each image 
affects resizing decisions. 

Bring Your 
"Day Into Night" Images!

Bring your prints or files on CD 
(at most 2 “before” and “after” 
images per person – that is, 4 in 
all) to the meeting, and show us 
how you applied “Day Into Night” 
techniques to one of your own 
images.

It's not required, but you will get more 
out of the meeting if you are able to 

bring laptops and power cords!
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Report on December DIPSIG Meeting
by Jerry Dupree

At the previous two meetings, the 
group had been learning portrait 
retouching techniques.  This 
meeting was an opportunity for 
members to show what they had 
been doing and how they did it. 

Dan Chalfont showed a number 
of pictures of his co workers he 
had taken and had changed backgrounds, 
lighting and settings. He showed several 
facial touchup techniques to improve the 
appearance of a picture.  Jerry Dupree 
showed two “models” who had been 
retouched.  One of the retouches also 
reduced the model’s weight by using the Free 
Transform tool to squeeze the image, therefore 
giving the impression of being thinner.  The 
“before” and “after” pictures looked like they 
were years younger. 

Joe Ramsey demonstrated a series of 
interesting Photoshop (or Photoshop 
Elements) techniques for changing a picture 
from “day” to “night” – and how to make it look 
like it’s raining by using the “noise” filter; how 
to darken the scene to take on the  blue tones 
of night; and  how to add stars, a moon, and 
clouds.  There are endless possibilities for how 
artistic one wants to be with digital imaging. 
Joe is summarizing his talk in an article to 
appear in two parts. Part I appears in this 
issue of e-focus: “Turning Day into Night - Part 1”

iView Media Review
by Joe Ramsey

Originally designed for Mac computers but now 
also available for PC Windows, iView Media is 
an easy-to-use cataloging program for making 
professional quality computer slide shows. You 
simply drag-and-drop or import photos and/or 
sound clips via menu commands. After all the 
files you want are placed in a catalog, which 
can be named to suit your show, the order in 
which they are displayed can be changed and the 
duration can also be adjusted either individually 
or globally in one second intervals from 0 to 60 
seconds. 

Sound tracks can be started to coincide with any 
slide. For instance, you can insert a voice sound 
clip that describes a particular photo and adjust 
the duration of the slide to match the duration of 
the sound clip. Great for narrating travel shows.

You can show images full screen or there are 
several templates for showing multiple images 
simultaneously. Transitions between slides are 
selectable globally, yet fades, wipes or other 
transitions can be applied to individual slides 
even within the global. If you need prints, contact 
sheets of any show can be printed directly from 
iView as well as individual images.

A companion program, iView Catalog Reader, is 
available as a free download. It permits burning 
your show to a CD that can be viewed by anyone 
with a PC or Mac without having to install iView 
Media on their computer. However, you do 
need iView Media to make the original catalog. 
iView Media Pro is a more powerful version of 
iView Media, but if you use images that were 
processed in Photoshop you do  not need iView 
Media Pro to make slide shows. Pro adds image 
adjustment functions which can be useful but not 
as comprehensive or refined as Photoshop.

For more information and to purchase iView 

Media, see http://www.iview-multimedia.com. The 
iView Catalog Reader can be downloaded for 
free from http://www.iview-multimedia.com/products/
download.html. A dtatsheet can also be obtained 
from http://www.iview-multimedia.com/press/ivm_
datasheet.pdf.

Joe Ramsey demonstrated the use of iView Media at the 
November DIPSIG meeting. Here he reviews its capabilities
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A Short (?) Primer on Layers: Part I
by Stuart Lynn

In earlier issues of e-focus and in last month’s 
edition of this column, I introduced the subject 
of “layer masking” (see December 2003 e-focus 
“Beginner’s Page: Layer Masking in Photoshop 
Elements”). I may have jumped the gun: not 
everyone understands what a “layer” is, let 
alone “layer masks”. In this article I backtrack 
slightly, and provide a brief primer on “layers”. 
It is written from a Photoshop Elements 
“perspective”, the tool of most beginners; 
Photoshop itself differs in some details, but the 
basic concepts are similar.

“Layers” are powerful tools that allow 
digigraphers to “stack” images or parts of images 
on top of one another and control how much of 
each image shows through and in what manner. 
Imagine you have painted a series of images on 
different sheets of transparent plastic, and then 
you stack these sheets on top of one another 
– you have created a stack of layers! 

Of course, one painting could cover an entire 
sheet of plastic, blocking anything showing 
through from the lower sheets or layers. But 
Photoshop Elements also allows you to control 
the transparency of each layer, so that some of 
the lower layers do show through an otherwise 
“blocking” image. And you can control other 
ways the layers interact with each other 
(“blending” for example, as we shall see later), 
and to create other interesting effects.

Getting to Work
Let’s plunge in, Open any image in Photoshop 
Elements. Click on the Layers tab at the top right-
hand corner to open the Layers Palette; and, still 
holding on to the tab, drag the palette down to 
“tear” it away from the dock (otherwise, it will 
keep closing after each use). You see an icon of 

your image on a layer labeled “Background”. 
Double-click anywhere on that layer to bring 
up a dialog box that allows you to change the 
name of the layer: change it to something more 
descriptive. (Renaming your layers is useful 
when you have several layers. It helps you to 
identify each layer.) Close the dialog box and you 
see your new name in the Layers palette.

Now open a second image in another window, 
preferably one of approximately the same size 
and resolution as your first image. Make a 
selection from this image (in the illustrations, I 
selected a “rose” from a larger image). Spread the 
two windows so that the second does not entirely 
block the first. Select your Move tool (type v as a 
shortcut to invoke the tool, or select it from your 
Toolbox). Holding down your mouse button, drag 
the selection (the “rose”) over the old image and 
release the mouse button.

What have you done? The new image sits on top 
of the old image, partially or wholly blocking the 
old image. You have created a second layer. Still 
using your Move tool and holding down your 

Fig 1: Original Image and Layers Palette
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mouse button, drag the new layer around on 
top of the original layer. There are also handles 
around this new layer allowing you to resize, 
distort, or rotate it as you wish.

Now look in your Layers palette. You see an icon 
of your new image in a new layer that sits on top 
of your old layer. You know how to rename this 
new layer (see above). Note that the new layer is 
highlighted, indicating that it has been selected. 
Click on the old layer, and it will become 
highlighted (selected) instead.

Now, clicking anywhere on the new layer in the 
Layers palette to select it and holding down your 
mouse button, drag it down below the old layer. 
You have reversed the “stacking” order so the 
old layer sits on top. This ability to control the 
stacking order is often important. Undo what 
you just did to restore the original stacking order 
(Ctl/Cmd-z).

Interactions Between Layers
But now the real fun begins. Select the top 
(new) layer. Now, in the Layers palette, click on 
the Opacity slider and drag it to the left. What 
happens? The further you move it to the left, the 
more of the bottom layer shows through! Your 
top layer has become partially transparent!

There are many reasons why transparency is 
important. We will give an example later in this 
article.

There’s more. Click on the little arrow by the 
small window in the Layers palette that currently 
displays the word “Normal”. This invokes 
a pulldown menu of choices affecting how 
the layers interact with each other, so-called 
“blending” of layers. The meaning of each of 
these different blending modes is beyond the 
scope of this article (some will be highlighted 
in future articles), and indeed some remain a 
mystery even to the most advanced aficionados. 

For now, why don’t you experiment by selecting 
each in turn to get a sense of how each one effects 
the ways in which layers interact? In the example, 
I have selected “Vivid Light”. In combination 
with use of the Opacity slider, many different 
beautiful effects can be created. Incidentally, 
two of the most important blending modes for 
digigraphers are “Multiply” and “Screen” – this 
will be featured in next month’s Beginners’ Page.

Modifying Your Original Image (Non-
Destructively)
Layers allow you to modify your image without 
losing the original image, in case you want to 
reverse your work. Let’s see how this operates 
in practice. Select your your new layer and then 
delete it by clicking on the “More” button at the 
top right of your Layers palette, This invokes a 
pulldown menu. Select Delete Layer and click on 
“Yes” from the dialog box that pops up. Or even 
quicker, just click on the Trash icon at the bottom 

Fig 2: The New Layer is Added

Fig 3: Changing Opacity and 
Blending Mode
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of the Layers palette. Now all that remains is your 
original layer.

Make a selection of part of your original image 
with the Marquis (shortcut: m) or Lasso (shortcut: 
l) tool. Now from the Edit menu, Copy and Paste 
this selection (you can also use shortcuts Ctl/
Cmd-c and Ctl/Cmd-v). Photoshop elements 
automatically pastes this selection to a new layer 
above your original layer – you can see it in 
the Layers palette. By the way, you could have 
copied and pasted the entire image to a new layer 
by selecting the entire image in the first place 
(shortcut: Ctl/Cmd-a), but a quicker way to do 
this is to choose Duplicate Layer from the More 
pulldown menu in the Layers palette.

Now, making sure your new layer is selected, 
apply a filter such as a Gaussian blur: 
Filter>Blur>Gaussian Blur. Make a good blur by 
choosing a radius of, say, 8.0.

Note that you have made the change to the copy 
of the original image, but the original remains 
intact. To convince yourself of this, temporarily 
turn off the top layer by clicking the eyeball to 
the left of the layer. All that shows is the bottom 
layer. Turn the eyeball back on and select the top 
layer. Now note that you can vary the amount 
of the blur by moving the Opacity slider in the 
Layers palette to the left, that is, changing the 
transparency of the top layer to combine the 
two layers. If you like, you can “finalize” your 
image by flattening the “stack” of layers (in this 
example, two layers), collapsing it into a single 
image. Just select “Flatten Image” from the More 
pulldown menu in the Layers palette. 

Note the other options in the More pulldown 
menu: Merge Down, used for merging a selected 
layer with the one below when you are working 
with a large stack of layers; and Merge Visible, 
useful when you want to just flatten a few layers 
from a whole stack – just turn off the eyeballs 
temporarily of the layers you do not want to 
collapse before invoking Merge Visible!

Special Layers
Photoshop Elements also provides three special 
kinds of layers: Adjustment Layers, Fill Layers, 

and Type Layers. We will defer discussion of 
these to a future article. Adjustment Layers and 
Fill Layers are both invoked from the Layers 
menu. Type layers are invoked by selecting the 
Type tool (shortcut: t). Of most importance to 
digigraphers are the Adjustment Layers. For 
example, invoking a Hue/Saturation Adjustment 
layer (Layers>New Adjustment Layer>Hue/
Saturation) places a separate layer on top of 
the selected layer that allows you to use the 
Hue/Saturation dialog without modifying the 
underlying layer(s), that is, retaining the original 
image! And you can manipulate the Opacity and 
Blending Modes of these Adjustment layers to 
determine how they interact with the underlying 
layer. Go ahead and experiment for now.

Fill and Adjustment Layers also allow you to add 
Layer Masks to control how much of the top layer 
is visible (see December 2003 e-focus: “Beginners’ 
Page: Layer Masking in Photoshop Elements). 

Layer Styles
One final note that we will take up in more 
detail in future articles. Photoshop Elements also 
allows you to create Layer Styles (also known as 
Layer Effects) invoked from the Layer Styles tab 
at the right of your Toolbar. These enable you to 
implement “drop shadows”, “neon glows”, and 
other interesting effects around the visible pieces 
on your layers (they really do not have much 
meaning when the layer consists of an image that 
fills the entire window). Again, for now, go ahead 
and experiment!

Layers are extremely powerful tools for building 
images. I find new ways to exploit them every 
time I use Photoshop or Photoshop Elements. 
There is much more than I can compress into this 
article, but I hope I have whetted your appetite to 
read more and experiment on your own. 

By the way, you can always create an empty 
new layer by clicking on the New Layer button 
at the bottom of the Layers palette (or click on 
Layers>New>Layer). Blank layers are useful when 
you want to paint into them, for example, using 
the Brush tool.
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Love me, Love my Dig
by Jerry Dupree

The advantages of digital photography are obvious; no film, therefore an unlimited 
amount of shots of a given subject.  You, as the photographer, can experiment with angles, 
exposures, flash, or other settings without running out of film.   You can immediately see 

the results and make any corrections in settings, perspective, or lighting.  You get all that and 
eliminate the cost of film and processing.  Who could argue with that? 

You also get to enhance, manipulate, lighten, darken, combine, crop, enlarge, and reduce the 
photo, and print it on photo paper, greeting cards, or many other types of media such as tee 
shirts, bumper stickers, and an endless assortment of banners, and holiday items.  You can 
store thousands of pictures on CD’s and DVD’s in a shoebox.  Try doing all of that with film! 

I bought my first digital camera several years ago and it 
recorded on a floppy disc.  Wow, I could get 20 pictures on a 
30-cent floppy disc, what a bargain.  They were reasonably 
good snap shots, but nothing worth framing.

The technology continued to advance faster than any 
consumer product I have ever seen.  I visited a commercial 

photo lab that specialized in digital photography and they “offered” me a high-end digital 
camera for $25,000.   I replied that I would wait until they came down 
to less than $5,000 before I would take a serious look at it.   Now, there 
are several digital cameras that can out shoot that one on the market for 
less than $2,000, and falling.

Canon has already brought to market – and others will surely 
follow very soon – an excellent SLR digital camera that costs less than 
$1,000.   I recently bought a Nikon D100 SLR because I had a collection 
of expensive Nikon lenses that have been taking up space.  Now I 
am finding the manufacturers are making lenses especially designed 
for digital SLR cameras that are light years beyond the earlier auto 
focus lenses. 

Friends and relatives have asked my advice 
on which type of camera to buy.  I believe the 
major brands are very competitive as far as 
technology goes.  Some folks like Chevies, 
some like Fords.  The same is true among 
photographers.  Some like Nikon, some like 
Canon.  There are many other fine brands. 

The major division comes at whether to get 
a “Big Zoom” or an SLR camera.   When traveling by air or by car, space and convenience 
mean a lot.  We have enough luggage to hump in and out of airports, hotels, and cars, without 
adding a few more pounds and cubic feet of lenses, tripods, and gear.  For that reason, I prefer 
to carry a 5.2 megapixel Sony F 707, which will soon be replaced by the newer 8.0 megapixel F 
828.  It is small enough, light enough, and takes excellent quality pictures.  With the added 

LOVE MY DIG...

LOVE ME...
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wide angle and telephoto adapters, I have not felt “under powered” as far as cameras are 
concerned. 

I used to laugh at the fathers at Disneyland bent over with a heavy camera around their neck, 
a camera case and tripod in one hand, and diaper bag in the other.  I never wanted to be that 
guy.  The high-end 4.0 to 6.0 megapixel zoom cameras are great for that kind of shooting. 

While in Hawaii, I was taking pictures of surfers riding waves.  I would center the surfer in the 
frame and shoot the picture, only to find that when it recorded the image, the surfer slipped 
away or wiped out.  I found that for 
anything moving that demanded 
a quick shot, or more than one 
shot, the Sony was inadequate. 

It was for that reason that I chose to buy a 6.0 megapixel Nikon D100.  While the Sony will 
remain as my primary camera, the Nikon will be for specialized photography such as nature 
and wildlife.   As one of my hobbies, I call predators and can entice them from a long distance 
to come in to my call.  I will be using the Nikon to bring in coyotes, foxes, bobcats, and 
badgers, and hopefully some mountain lions for some candid shots.  The call works equally 
well for owls, hawks, eagles, and ravens.  I have an 80-400mm telephoto zoom lens to shoot 
wildlife pictures.  Recently, I have been shooting 
pictures of hummingbirds.  We installed a feeder 
outside of our kitchen window and with the 
lights off, at the right time of day, I sit and wait for 
hummingbirds to show themselves in front of my 
lens long enough to get some pictures. 

I have been experimenting with shutter speed and lighting to try photographing a 
hummingbird and stopping its wing motion.  That kind of photography is only possible with a 
more advanced SLR camera.

“You Get All That And Eliminate The Cost Of Film 
And Processing. Who Could Argue With That?”

This is the first, in what will be an oc-
casional series, of articles by club 
members and others on what they 
particularly like about their digital 

camera – Ed

TIP OF THE MONTH:

Two Gradients for the Price of One!
In several articles in this issue of e-focus (see “Transition Masks – Making the Grade”), we describe how to use 
gradients in masks to create a smooth transition between different layers, what I call a “transition mask”. 
But often you want to use two gradients in the same mask for even more interesting effects. Can this be 
done – without the second gradient wiping out the first?

You bet. The trick is for the first mask as usual to use a black to white gradient as described in the article. 
But for the second mask, use a black to transparent gradient.You select this option in the Gradient Toolbar 
at the top of the screen when the Gradient tool is selected.

You can even add a third and fourth gradient that way! Try it.

Thanks again  to Steve Broback of Avondale Media for this tip. Click here for more tips from his website.– 
MSL
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Woody’s Corner
by Woody Kaplan

MEMORY! KNOW WHAT?

Now that you have that new camera with a 16mb card, what do you do now?

My suggestion is to get on line and start looking for the biggest memory card you can 
afford. Just in case youʼve been locked up in the closet of late, prices are dropping faster then the 
price of gas has been going up.

Think of all the trips of interest you have taken with film. Some years ago the “little woman” and I 
went to Africa for 30 days: she used film and I shot digital. One thing you donʼt want to ever do is 
run out of film or memory on a trip of a lifetime. Digital memory was easy  – obviously I could pack 
all I had in virtually no space at all and it was just not a weight factor. Bulky film on the other hand 
required its own suitcase significantly adding to the total weight. Digital is so much more convenient 
– I canʼt understand why everybody has not yet switched!

Digital “everything” is our future. The way we live is changing all around us. Have you been in for 
medical testing that required an MRI lately? In the “old” days it was done with film and it wasnʼt easy 
to obtain copies for all your doctors, and the cost was much greater. Today MRIs are stored digitally 
– and copies can be emailed to your doctor in minutes. And 2004 is projected to be the turnaround 
year for movies when they convert to all digital format.

Now that we all realize digital has changed our life style, we must shop for the best prices for digital 
memory.

From time to time in this Column, I will update you on whatʼs new and where the best bargains 
can be found. This will help us all save money so that we can afford our next digital camera! Yes, 
obsolescence is a factor. A digital camera does not cost $1,000 – it costs $300 a year for life. But itʼs 
worth it – and each cycle brings so much more capability!

While shopping around for a bigger compact flash card for my Olympus E-20 I came across a site 
with great prices. How about a 1gb MicroDrive for less then $140? How about a 2gb MicroDrive for 
less then $200? Only a year ago, you could expect to pay around $400 for a 1gb Micordrive.

Link to http://www.mydigitaldiscount.com. All kinds of goodies can be found: MP3 players, batteries, 
hard drives, and naturally any kind of memory (wish I could find brain memory ;-))

Scour the Internet yourself. Let us know if you find lower prices or “must have items.” This Column 
is for all of us, and we can all help each other.

Woody’s Corner Cotinued On Next Page
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More of the Future

What will “they” come up with next? Just when you thought it was safe to say, “ They canʼt top this 
do-hickey,” along comes something new.

3D Is Easy

How would you like to shoot and show 3-D pictures without giving up your first born? For less 
the $130 you can have eye-popping pictures. Sure you must wear 3D glasses but can you imagine 
looking at a picture of our new governor, contours and all, vs. a boring flat picture?

Link to: http://www.Photo3-D.com 

The Best Little Picture SlideShow Maker on the Web

So many programs, so little time to use them all.  Each of us have different views on showing 
pictures. How about nice, neat little package called “iView”? See Joe Ramseyʼs review of this product  
in this issue of e-focus: “iView Media Review”.

Check this out: http://www.iview-multimedia.com

Facelifts Made Easy

If only life was this simple! Only $29.95 and you can make that less then perfect picture a “Mona 
Lisa.”   Try it free for 7 days.

 Only one little thing wrong with program, Windows only.

For true fun: http://www.facefilter.com

Emailing Photos with a Flair

Make your own stationery, drop as many pictures as you want into letter and send by any email 
service. Over 100 fun and creative stationery designs. (Windows program, but can be used on Virtual 
PC on a Mac).

30 day money back guarantee: http://www.sendphotos.com

Woody’s Corner Continued From Previous Page
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Then we will present a two or three illustrative 
examples where they might prove useful.

Making a Transition Mask 
Let’s use the same example we used in the “basic 
concepts article”, a red layer sitting on top of a 
blue layer. Add a layer mask to the red layer (you 
remember how to do this – and you practiced 
doing it, right?), by clicking on the New Layer 
button (second from the left) at the bottom of 

the Layers Palette. As always, this fresh mask is 
painted pristine white – so only the top layer 
– the red layer in our example – shows. And the 
mask itself is selected (shown by the double line 
around it in the top layer). See Figure 1.

Now click to select your Gradient tool in your 
Toolbox (it may be hidden behind your Paint 
Bucket tool, so you may need to click on the 
little arrow to reveal your Gradient tool). Note 
this brings up a dialog box in your Toolbar at the 
top of the window. It presents several choices, 
including whether to select a linear gradient, 
a radial gradient, or other gradients. For now, 
make sure you have selected a linear gradient 
(see Figure 2). Note also that the gradient layer is 

represented with white on the left shading to 
black on the right.

Transition Masks – Making the Grade

by Stuart Lynn

In an article “Layer Masking: the Basic Concepts” 
in December 2003 e-focus, I reviewed the basic 
theory underlying layer masking in Photoshop. 
I deferred to this issue some ideas on how layer 
masking can be used in neat ways to improve 
your images. “Transition Masks” is one of those 
ways.

By the way, this works best in Photoshop. It’s 
application in Photoshop Elements is limited. But 
it’s still useful to understand the idea, because it 
has applications there, too !  Remember, the main 
constraint is that in Elements, you can only apply 
masks to certain special kinds of layers.

The name “Transition Masks” is mine. I would 
prefer to call them “Gradient Masks” since they 

make use of gradients, but that means something 
else in Photoshop and Photoshop Elements. Too 
bad!
 
The idea is simple, First, makes sure you have 
read the “basic concepts” article in the last issue 
and understand the concept of layer masking. 
You now know that wherever the mask is painted 
black, the underneath layer shows through; 
wherever it is painted white, only the top layer 
shows; and wherever it is painted gray, a mixture 
of the two layer shows. The darker the gray, the 
more of the bottom layer shows – just as if you 
had set your Opacity slider in the Layers Palette  
somewhat over to the left.

But if you could use your Gradient tool to paint 
a continuous gradient from black to white into 
your mask, then the image would smoothly 
change from the bottom layer to the top layer! 
That is what I mean by a “Transition Mask”.

Let’s look at how to create  “transition masks”. 

Making Smooth Transitions 
Between Layers

Fig 1: Adding a Layer Mask

Fig 2: Selecting a Linear Gradient
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Making sure the mask is selected in the “red” 
layer (if not, just click on it) as well as the 
Gradient, click somewhere in the top left of your 
image and keep holding the mouse button down. 

Now drag a line to somewhere in the bottom 
right corner and release your mouse button.

Wow! Two things have happened (see Figure 3). 
First, your image is now continuously changing 
from red to blue through various shades of 
purple. And you can see why because, second, 
in your layer mask you can see that you have 
painted a smooth gradient from white to black 
– and you know what layer masks do to your 
image layers. It is white on the top left allowing 
the red top layer to show, and blue on the bottom 
right allowing the lower blue layer to show. 
White to black, because you dragged that way 
and that is how the gradient is showing in the 
tool bar.

What would happen if you used a radial gradient 
instead of a linear gradient. Well, just experiment. 
Undo what you last did (Ctl/Cmd-z) and click on 
the Radial Gradient in the Toolbar (see Figure 4). 
Now drag your line from the center of the
red image out towards the corners and release. 

You have now created an image (Figure 5) which 
radially changes from red in the center to blue 
at the edges. And you can see why by looking at 
what has happened to your layer mask.

So that’s what “transition masks” are all about 
– ways of creating smooth transitions between 
layers.

Oh, one more thing. If you double-click on the 
gradient icon in your Toolbar, a dialog box will 
pop up (Figure 6) that allows you to fine tune 
your gradient. If, for example, you want a more 
gradual transition from white to black in your 
layer mask, just move the center point on the 
slider to the right. You may want to experiment 
with different settings so you learn how to gain 
precise control.

So What’s The Use?

These “transition masks” are very powerful. 
In other articles in this issue of e-focus, I show 
how they can be used for more precise blurring 
of backgrounds when, for example, improving 
portraits as we reviewed in the December, 2003 
issue of e-focus. I also show how they can be 
used for “Making Shadows Sing”, and how to 
counter the fall-off effect that often occurs with 
the use of flash.

In a nice application at the last DIPSIG meeting, 
Joe Ramsey showed how a “transition mask” 
could be used to make added light fall off with 
distance from its source (in this case, a window lit 
at night) as it lights up the surrounding area.

You will find other ways, too. By the way, in 
this month’s “Tip of the Month”, I show how to 
add two “transition masks” to the same image. 
Comes in useful at times.
(Footnotes)
1 Recall our convention that Ctl/Cmd-z means 
Ctl-z on a PC and Cmd-z on a Mac.

Fig 6: Adjusting the Gradient

Fig 3: Applying a “Transition” Mask

Fig 4: Selecting a Radial Gradient

Fig 5: Applying a Radial “Transition” Mask
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1. Blurring Backgrounds The Right Way

In the December 2003 issue of e-focus, I described 
“Ten Digi-Steps to Better Portraits”, including 
the step of blurring the background to focus 
attention on the portraits itself. I suggested 
using the Gaussian Blur filter after selecting the 
background.

The problem is that this blurs the entire 
background uniformly, ignoring the fact that 
those parts of the background that are closer to 
the portrait (which is presumably in sharp focus) 
will be sharper than those parts that are further 
away. Fortunately, we now have another tool 
at our disposal to come to the rescue: Transition 
Masks as described in this month’s Feature Article. 
You will want to read that article before reading 
this one.

How does this work? Let’s go back and look at 
the portrait that occupied our attention in last 
month’s article. Recall that we selected and then 
blurred the background. This time, before blurring 

the background, copy 
it to a new layer (Ctl/
Cmd–j in Photoshop, 
or Copy and Paste in 
Photoshop Elements). 
Call it “MyBackground” 
to distinguish it from 
the original Background 
layer. Unfortunately, 
Photoshop labels the 

original layer Background, which confuses the 
term with the sense in which we are meaning 
the background to the portrait. You can figure 
it out, I’m quie sure! Once the background is 
safely on the new layer above the original layer, 
you can proceed to blur that new layer using 
Filter: Gaussian Blur according to taste. Blur it 
sufficiently so that the areas furthest away look 
right.

Now we want the areas further back to remain 
blurred, and those closer to be sharper. Here’s 
where “transition masks” come into play, just as 

in the previous article: “Transition Masks – Making the 
Grade”.

Just add a layer mask to the top MyBackground 
layer. Then select your Gradient tool from the 
Toolbox. Make sure you have selected a linear 
gradient in the Toolbar.  
Also make sure your 
foreground color 
is black and your 
background color 
is white (typing the 
character “d” on the 
keyboard is a shortcut 
that makes this happen). 

Now click on the 
background to the portrait at a point furthest 
away from the portrait – in this example, 
somewhere around the base of the trees.  But 
don’t release your mouse button. While keeping the 
mouse button down, drag a line vertically down 
to somewhere around the plane of the portrait, 
and then release your mouse button.

What has happened? You can see the gradient 
“painted” into your Layer Mask icon. And you 
know the effect by now. Where the mask is white, 
the blurry top layer shows – that is, towards the 
“back” of the picture. Where the mask is black, 
the sharp top layer shows – that is, towards the 
v“front” of the picture. And the grays in between 

of the gradient ensure 
a smooth transition 
from one into the 
other.

Since the effect may 
be hard to see in the 
small images above, 
here is a  slice of each 
image that may make 
it easier to see what is 
going on

Problem solved!

Before (Blurred)

Before

After
 (Graduated Blur)

After

PUTTING TRANSITION MASKS TO WORK:
TWO (and a half!) EXAMPLES
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The third example “Making 
Shadows Sing”, that was promised 
in the December 2003 issue, 
was not ready in time to meet 
the deadline for this issue. My 
apologies to readers!

The idea is essentially to apply 
“transition masks” to harsh 
shadows to provide a somewhat 
smoother, or graduated, shadow. 
First copy a selection of the 
shadow to a new layer. Second, 
lighten the new layer. Third, 
apply a “transition” mask to 
gradually change the shadow 
from its original dark tones nearer 
the object casting the shadow to 
the lighter shadow further away 
from the object.

But it is not as simple as this 
description would imply. Shadow 
tones have to be carefully 
monitored. Often, the far edges 
of the shadow become harsh or 
ultra-light borders that have to 
be cloned out with the Stamp 
tool. Occasionally, more than one 
gradient has to be applied (see 
this issue “Tip of the Month”) because 
of changing directions fo the 
shadows.

2. Removing  Flash “Drop-Off” Effects

Flash is both a blessing and a 
curse. Used correctly, it provides 
an essential light source. But 
there are many pitfalls in its use 
that can lead to ugly effects. The 
worst of these is harsh shadows. 
Perhaps the next in order is that 
because its power drops off 
so rapidly with distance, closer 
objects appear so much brighter 

than those further away 
– and this “drop-off” effect 
plays out even over short 
distances of a few feet.

“Transition” Masks to the 
rescue! Simply duplicate 
the image to another layer, 
and lighten that layer (you 
can use the Lighten slider in 

the Hue/Saturation window – invoked with Ctl/
Cmd-u; or blend the two layers using Screen in 
the Layers Palette) to the point where the darker 
(further away) area in the 
duplicate layer (normally at the 
top of the image) more closely 
matches the lighter (closer) area 
in the original layer (normally 
at the bottom of the image). 
Now apply a “transition” mask 
to this duplicate layer, using a 
white-to-black linear gradient 

in the mask. See previous article “Transition Masks 
– Making the Grade” for the mechanics of doing this. 
And the whys and wherefores of how it works.

Presto! The “transition” mask has graded the 
areas into a more uniform lighting appearance. 

Problem solved!

Before

After



– 17 –

OFFICERS:
President: Joe Ramsey; prex@cvdcc.org
Vice President: Lillian Roberts; viceprex@cvdcc.org
Treasurer: Joan Petit-Clair; treasurer@cvdcc.org 
Secretary: Judie Ruzek; secretary@cvdcc.org
Past President: Woody Kaplan; pastprex@cvdcc.org

NEWSLETTER EDITORS:
In Focus: Lillian Roberts; infocus@cvdcc.org
E-Focus: Stuart Lynn; efocus@cvdcc.org

WEBSITE:
http://www.cvdcc.org

COMMITTEE CHAIRS:

Competition: Joan Petit-Clair
Digital (DIPSIG)v: Joe Ramsey
Membership: Jean Cohen
Programs: Lillian Roberts
Publicity: Shirley Brenon
Special Projects: Joan Petit-Clair
Social Programs: Shirley Brenon
Ways and Means: Karen Wheeler
S4C Delegates: Joan Petit-Clair, 
Lillian Roberts 
S4C Print Chair: Bob Graf  

E-FOCUS IS ISSUED AS AN ELECTRONIC SUPPLEMENT TO 
IN FOCUS, THE NEWSLETTER 
OF THE COACHELLA VALLEY DESERT CAMERA CLUB

COPYRIGHT NOTICE

Copyright to each article in this e-focus Newsletter remains with the creator of the article, that is, with the 

original author. Permission to copy, but not to republish, for non-commercial purposes is given, provided that 

the source (publication author, date, link) is given. To copy otherwise, or to republish, requires permission 

(contact efocus@cvdcc.org)


